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Introduction  Chapter 1 

Chapter 1 Introduction 
MxM™ is a collaboration tool engineered for groups that work in multiple locations. It is intended to 
revolutionize the way groups and individuals work in day-to-day operations. This software lets an 
organization reconstruct their dispersed environment into a virtual model and operate in that model just as 
in actual life. The difference is that the dispersed locations can work as if they were co-located.  

The MxM Model 
MxM lets you track the availability of your fellow MxM users and run text chat sessions with any 
combination of available users, wherever they are located.  To aid in tracking participants and events, 
each session lists the occupants in or connected to it. A log and a session narration tracks transactions in 
the session as well as who enters and leaves the session. 

With the MxM Places license on the system, your administrator can establish a hierarchy of permanent 
sites for text chats.  By establishing levels and picking labels and icons, your administrator can customize 
this environment for your organization.  For example, the environment can represent a building divided 
into separate floors, divided into rooms.  See the "Places" chapter. 

With the MxM Audio license on the system, you can run VOIP (Voice Over IP) conversations in parallel 
with any text chat. 

With the MxM Shared View license on the system, any user can show other users a window onto their 
computer desktop. 
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Documentation  
The Documentation link located on the MxM page taskbar lets you view MxM manuals, as well as MxM 
user web help.  

 

Figure 1: MxM Page, Documentation Link on Right 

To access the MxM user documentation, or to access the online help for the MxM applications, click the 
link to select the guide or help you want to view.  The manuals are in Portable Document Format (PDF) 
and HTML format; to view the PDF documentation, you must have Adobe Reader installed.  Adobe 
Reader lets you print copies of the guides that look just as they display on your computer monitor.  

 

Figure 2: MxM Documentation Page  

Click on Manual to open the PDF version of a guide; click on Web Help to view a web version of a 
guide. 
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Chapter 2 Logging On 
To log on to MxM for normal use: 

1. Open your web browser and enter the URL for the MxM portal:  
Example: http://your.server          

Use Microsoft Internet Explorer 7 or higher. MxM uses the Java Runtime Environment, Standard 
Edition V1.6.0 or higher. If your system does not have this, MxM installs it for you. 

The browser displays the MxM home screen. 

 

Figure 3: MxM Home Screen 

2. Click on Collaborate. The first time you click Collaborate, MxM downloads the application to your 
machine and puts an icon on your desktop. MxM then displays the Login window. 

 

Figure 4: Login Window 

 MxM User's Guide 3 



Chapter 2  Logging On 

If you check Save password, MxM includes your password (masked) next time you log in. 

Check High security if the administrator tells you to.  This increases security from TLS to compliant 
with FIPS 140-2. 

3. Enter your username and password.  You may also need to supply your authentication source; ask 
your administrator.  Then click Log on.  If you have checked Show login status, MxM displays the 
Log On Status window.  To close the Log On Status window, click on OK.  If you prefer not to see 
the Log On Status window, check Do not show me this display in the future. 

 

Figure 5: Log On Status 

MxM displays the main window.  

From here, you can: 

 View the list of other users and their 
availability. 

 View the groups you are in and the other  
users in those groups. 

 Start a chat session with other users. 

 View and go to available places. 

 View your buddy lists. 

 Set Options/Preferences for: 
 – Text chat 
 – Audio chat, if available 
 – Sounds 
 – Buddy list membership 

 

 

Figure 6: MxM Main Window 
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To change passwords: 

1. Click Change Password. MxM opens a Change Password dialog box. 

2. Enter your new password, retype it to verify it, then click Log On (or Cancel if you want to discard 
the new password).  

 

Figure 7: Change Password 

Note: The colored box at the end of the New Password field indicates the strength of the password and 
can by red (very weak)  , yellow (weak)  , or green (strong)  .  Use a mixture of letters and numbers, 
and make the password long enough to be strong. 

Note: If you supply an authentication source to log on, you are not allowed to change your password from 
MxM. 
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Chapter 3 Main Window 
After you log in, MxM displays the main window.  This is the point from which you can access all the 
other MxM functions.  From the window, you can start chat sessions, use buddy lists, view the current list 
of users or the current list of places, and set your user options. 

 

Figure 8: MxM Main Window  

Buddy List 
This tab displays a list of the people and groups you have put on your buddy list.  It displays the user 
groups you belong to, if you have checked Show Groups at the top of the tab.  See the "Buddy Lists" 
section in the "People" chapter. 

Online Users 
This tab displays a list of the people currently using MxM on your server.  See the "Online Users" section 
in the "People" chapter.    

Places 
This tab appears only if your system has an MxM Places license.  It displays a list of the places currently 
defined and permitted for you on your MxM server.  See the "PlacesPlaces" chapter. 
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Current Status 
MxM tracks the status of all users.  Your own current status appears at the top of the main window, with a 
color-coded button: 

 Available — You are available for chat sessions.  This is the default. 

 Do Not Disturb — You are logged in but do not wish to join chat sessions.   

 Away — You are logged in but not at your computer.  

 Extended Away —  You are logged in but not at your computer.   

When your name appears on users' Online Users list, they see the status you have selected, with the color-
coded button and, if the button is red, with your away message if you have selected one.   

To change your current status: 

1. Click on the status.  MxM displays a menu listing the four options for status. 

2. Click on the option you want. 

 

Figure 9: Pulldown Menus for Current Status – Changing Status 
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To change your current status and select an away message: 

1. Click on the status.  MxM displays a menu listing the four options for status. 

2. Hold your pointer over the option you want. MxM displays a menu listing Custom… and the 
currently available selection of away messages, with the current choice marked with a check. 

3. Click on the option you want. 

 

Figure 10: Pulldown Menus for Current Status – Selecting Away Message 

 

To enter a new away message: 

1. Click on the status.  MxM displays a menu listing the four options for status. 

2. Hold your pointer over an option. MxM displays a menu listing Custom… and the currently available 
selection of away messages, with the current choice marked with a check. 

3. Click on Custom…  The Custom… entry changes into a field containing the message  
<enter your custom msg here> 

4. Enter the text for the new message and press Enter. 

The menus update with the new message appearing on the list of away messages. 

 

Figure 11: Pulldown Menus for Current Status – Entering Away Message 
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To edit an away message: 

1. Click on the status.  MxM displays a menu listing the four options for status. 

2. Hold your pointer over an option. MxM displays a menu listing Custom… and the currently available 
selection of away messages, with the current choice marked with a check. 

3. Hold your pointer over the message you want to edit.  MxM displays a menu giving you the options 
Modify… and Delete.  

4. To delete the selected away message, click on Delete. 
 
To edit the selected away message, click on Modify…  MxM opens the Custom… field and displays 
the selected away message.  Edit the text and press Enter. 

The menus update with the revised message on the list of away messages. 

 

Figure 12: Pulldown Menus for Current Status – Editing Away Message 

Chat 
To start a chat with another user, select their name from your Buddy List or the Online Users list, then 
click on the Chat button. MxM displays a chat window, showing your invitation to the other user: 

 

Figure 13: Chat Window from Sent Invitation 
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You can select several people from your Buddy List or Online Users list, for a multiuser chat session.  
Hold down the Ctrl key as you click on each name; you can hold down the Shift key to select consecutive 
names.  You can also select a predefined group of people by clicking a group name then clicking Chat.  
See the "
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Buddy List Groups" section in the "People" Chapter. 

You can add more users to the chat session later.  See the "Users Menu" section later. 

When you send an invitation, MxM displays an invitation message to the other user if this option is 
enabled on their client: 

 

Figure 14: Chat Invitation 

If the other user clicks on Accept, they enter the chat and see their own version of the chat window: 

 

Figure 15: Chat Window for Accepted Invitation 

Note: To automatically accept these invitations, select the Options menu, choose Preferences, select the 
Text Chat tab, then check the Automatically accept chat invitations box.  

To send text to the other user, click in the text entry pane on the lower right, type your message, then 
press Enter or click on Send.  Your text appears in the text pane above. 

To adjust the sizes of the panes, place your cursor on the bar between them, click and hold, then move 

ssion.  To 
 the other 

inal chat session. 

the cursor. 

The Private button lets you start a new chat session with one of the users in the current se start 
a private chat, select the user from the Who's Here pane, then click on Private.  You and user 
also remain in the orig
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l people for a multiuser private chat session, hold down the Ctrl key as you click on 
can hold down the Shift key to select consecutive names. 

The Eject button lets the person who started the chat session remove other users from the session.  To 
eject a user from a chat, select the user from the Who's Here pane, then click on Eject.  This can be 

sically ut exiting.  

e menus and menu options available in a chat session: 

To select severa
each name; you 

useful when the other user has phy  left their computer witho

To select several people for ejection, hold down the Ctrl key as you click on each name; you can hold 
down the Shift key to select consecutive names. 

The following figure shows the chat window and th

 

The  

Figure 16: MxM Chat Window 

  icon indicates a user with audio capability.  The    icon indicates a user with text chat capability. 

nmute, and Mute All buttons and the level meter ( For information on the Talk, Mute, U  ), see 

nd their options are described in the following sections. 

the "Media" chapter.Media 

The chat menus a
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File Menu 

 

This menu has the Save Chat History… and Close options.  Save Chat History… lets you store the current 
chat history (everything that has appeared in the main text pane) in a text file.  When you pick this option, 
MxM opens a dialog b hat prompts you for the name and location of the text file. ox t

The Close option closes the current chat window. 

Edit Menu 

 

This menu ha , Cut, and Paste options that let you edit text in the text entry pane, copy text from 
entry pane and 

s Copy
the main text pane, and move text between the text outside document files.  You can use 
Ctrl+C, Ctrl+X, and Ctrl+V for the same functions. 

Display Menu 

 

This menu has the following options, controlling the way entries are displayed in the main text pane: 

Show Timestamp — Select to include a timestamp for each entry in the chat log. 

 for 
1:00 PM.  This option is grayed out if you check Use Locale Format. 

Include Date in Timestamp — Select to make timestamps include the date.  This option is grayed out if 
you do not check Show Timestamp. 

Use Locale Format — Select to make MxM use the formats for time, date, number, etc., used on the 
resident system. 

Use Local Time Zone — Select to make timestamps express the time in terms of the local time zone.   

Suppress Narrative — Select to hide system messages, such as Walter Plinge has entered the chat. 

Use 24-Hour Format — Select to make timestamps express the time in 24-hour format, e.g. 13:00

 MxM User's Guide 13 
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Always On Top — S
so easier to find. (Thi

elect to make the chat window always be the top MxM window on your screen and 
s does not work perfectly if the system has several "always on top" windows.) 

You can also control these features through Preferences on the Options menu.  Use the Text Chat tab. 

Users Menu 

 

This menu has the following options, controlling access to other users: 

dd a user to the chat session.  The option opens a window displaying current 
users.  Select a user and click OK.  

Tools Menu 

Add User… — Select to a

 

The Tools menu has only the Shared View and Whiteboard options.  See the "Shared View" and 
"Whiteboard" chapters. 

Help Menu 

 

The Help menu leads to the online help on Chat or Audio. 

Options  

 

The Options menu in the main window has options controlling MxM's behavior for your account. 

14 MxM User's Guide 



Main Window  Chapter 3 

Preferences... 

 

This option opens a window with tabs for specifying your user preferences. 

Text Chat 

 

Figure 17: Text Chat Tab 
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Under this tab, you can select the following: 

Automatically Accept Chat Invitations — Select to join a chat session as soon as the invitation is 
issued, without bothering to click Accept.  

Show Timestamp — Select to include a timestamp for each entry in the chat log. 

Show 24-Hour Time — Select to make timestamps express the time in 24-hour format, e.g. 13:00 for 
1:00 PM.   

Include Date in Timestamp — Select to make timestamps include the date.   

Use Locale Format — Select to make MxM use the formats for time, date, number, etc., used on the 
resident system. 

e in terms of the local time zone.   

> 

ge, as well. << NEW >> 

age — Select to make the chat window icon in the desktop 
chat session.  

dow always be the top MxM window on your 
ystem has several "always on top" 

lor options — Select to specify the font style and color for your own chat entries, the 

lick for help on the Text Chat tab. 

Save — Click to save selections for the next chat session. 

Cancel — Click to close the Preferences window. 

You can also control some of these features through the Display menu on the Chat window, but changes 
made through the Display menu only apply to the current chat session.  Changes made here, under the 
Options menu Text Chat tab, apply to all future chats sessions until your next change. 

Media Settings 

The Media Setting tab appears in your Preferences window only if you have an MxM Audio license or 
Shared View license.  See the "Media" and "Shared View" chapters.  

Use Local Time Zone — Select to make timestamps express the tim

Translation service — Select Google Translate or WebSphere Translate as the default service for your 
chat and place windows. << NEW >

Translation language — Select the language you mean to use in your chat and place windows.  Incoming 
text is translated into this langua

Show Narrative — Select to show system messages, such as Walter Plinge has entered the chat. 

Blink Icon When Receive New Text Mess
taskbar blink when new text appears in the 

Keep Chat Window on Top — Select to make the chat win
screen and so easy to find. (This does not work perfectly if the s
windows.) 

Text style and co
names and entries of other users, and system messages. 

Help — C
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Sounds 

 

Under this tab, you can specify sounds to signal events in the chat: 

Enter Chat — Select to have MxM play a doorbell chime to signal someone entering the chat session.  
Use the slider to adjust the volume. 

Exit Chat — Select to have MxM play a door closing to signal someone leaving the chat session.  User 
the slider to adjust the volume. 

Chat Invitation — Select to have MxM play a telephone ring to signal a chat invitation window opening.  
User the slider to adjust the volume. 

Help — Click for help on the Sounds tab. 

Save — Click to save selections for the next chat session. 

Cancel — Click to close the Preferences window. 

Buddy List 

Under this tab, you can manage your buddy list.  See the section "Buddy List Groups" in the "People" 
chapter. 
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one you prefer.  

Look and Feel 

This option opens a menu of appearances for MxM windows.  Select the 

 

Figure 18: Look and Feel, "Sahara" Opt on i
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Chapter 4 People 
You can get information on other users in each tab of the main window. 

Online Users 
, look on the Online Users tab.  It lists all the people 

issions allow you to see. 
To see which people are currently using MxM
currently using MxM on your server that your perm

 
 
Figure 19: Online Users Tab 
 

Each person is listed by display name, followed by their authentication source in parentheses (such as 
Rservr in the figure above).  If a name has a number in parentheses after it, this means the user has started 
multiple sessions on MxM; Nick Bourbaki (2) is the second session Nick Bourbaki has started, without 
logging out from the first session.  Each name comes with a colored button indicating the user's status. 

To see another person's status, look on the Online Users tab. Their status is displayed next to 
nline. 

To chat with another user, select their name from the Online Users list, then click on the Chat button. 
MxM displays a chat window, showing you already entered in the chat.  MxM also displays a similar 
window to the other user after they accept the invitation to join the chat. 

Users that are logged in and available for chat sessions have their names and authentication source listed. 

their name.  If they are not listed, they are not o

 MxM User's Guide 19 



Chapter 4  People 

Users that are logged in but unavailable have their names and authentication source listed, and a messa
including any individual status message, for Do not disturb, Away, and Extended Away status. 

ge, 

 

Figure 20: Online Users Status Messages 

Places 
The Places tab appears only if your system has an MxM Places license.  It shows all places available for 
your use, in a hierarchical list.  The number of people in each place is given in parentheses after the place 
name, e.g. Flamingo Room(3). 

To see who is in a place, without entering it, hold your mouse pointer over the place's name on the list.  
If there are any occupants, their usernames appear in a small display. If the list has been displayed for a 
long time, click the Refresh button first, to get the most current information. 

 

Figure 21: Places Tab with Occupancy Display 
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Places are basically permanent, named chat sessions. They have the same menus and menu options as 
ou enter a place, MxM displays a chat window identical to the ones used for 
 the title bar showing the place name and a place icon.  People can enter the room 

nother person's authentication server while in a place or chat session with them, hold your 
pointer over their name in the Who's Here pane.  The information appears in a small display.  

chat sessions.  When y
private chats, but with
without an invitation. 

To see a

 

Figure 22: Places Window, with Server Display  
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Buddy Lists 
The Buddy List tab gives you a way to reach frequent contacts more quickly, and to organize them into 
groups. 

 

Figure 23: Main Window, Buddy List Tab 

To see user groups you belong to, check the Show Groups box above the list pane.  The groups you 
se groups are defined by the 

administrator; do not confuse them with buddy list groups, which you define for yourself. 

Offline box above the list pane. 

ase of George Spelvin in the screen above, have their 
names listed after a gray button: 

belong to will display in a hierarchical list, with Users at the top.  The

To see offline members of your buddy list, check the Show 

 Members that are not logged in, as in the c
 . 

t members that are logged in and available for chat sessions, as in the case of Alexandra 
Keje and Nick Bourbaki, have their names listed after a green button: 

 Buddy Lis
 .   

ers that are logged in but unavailable, as in the case of Alan Smythe, have their names and a 
message, including any individual status message, listed after a red button: 

 Memb
 . 

To start a chat with someone on your buddy list: select their name, then click on Chat.  
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To start a chat with all mem
Chat. Provided they are logge

bers of a group on your buddy list: select the group name, then click on 
d in, MxM displays a chat window, showing you entered in the chat.  MxM 

 

also displays a similar window to the other user once they accept the invitation to the chat. 

To manage your buddy list, open the Options menu, select Preferences…, then click on the Buddy List
tab. MxM displays your current buddy list, including any groups on the list. 

 

Figure 24: Buddy List Management Tab on Preferences… Menu 

Not
sec ps to the buddy list. 

Hel

Search — Click to bring up the list of available users on the lower pane.  See the next section, "Buddy 

Add Person — Click to add a selected person to a buddy list group.  See the next section, "Buddy List 

Cancel — Click to close the Preferences window. 

e: The first time you open your buddy list in Preferences…, you have no groups.  See the following 
tion, "Buddy List Group," to add grou

p — Click for help on the Buddy List tab. 

List Groups." 

Groups." 
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Buddy List Groups 

y, and delete these groups to reflect your 
the Buddy List tab displays if you 

indow; user groups are defined by the 
 the Preferences… option. 

The buddy list displays groups of users.  You can create, modif
needs.  These buddy list groups are not the same as the user groups 
check the Show Groups box above the list pane of the main w
administrator and cannot be modified through

 

Figure 25: Buddy List Groups 

The first time you use the Buddy List tab, you will see Buddy List in the Group Name field.  Click Add 
Group to establish Buddy List as a buddy list group. 

To add a group to the buddy list: 

1. In the Group Name field, enter the name of group you want to add, then click on Add Group.  MxM 

. The new group starts with no members.  Enter members in the group using the Search and Add 
Person buttons described next.   

To add someone to a buddy list group: 

1. In the upper pane of the Buddy List tab, click on the group you want to add the new person to.  

2. Click on Search to bring up the user list on the lower pane, then select the person's name.  

If the name is hard to locate, enter it or part of it in the Search field and click on the Search button 
again. Searching may take a few seconds. To search for someone by their email address or part of it, 
click on the By Email radio button.  

To select several people at once, hold down the Ctrl key as you click on each name; you can hold 
down the Shift key to select consecutive names. 

3. Click on Add Person. The person's name is added to the buddy list in the upper pane, under the 
group you have selected. (If you have not selected a group, Add Person is unavailable.) 

To remove someone from the buddy list, select the person's name from the upper pane and click on 
Delete. 

adds the new group to the buddy list. 

2
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me: 

1. In the upper pane, click on the group you want to rename. 

2. In the  field, enter the new name of group. 

1. In the upper pane, click on the group you want to remove. 

2. Click on Delete. 

3. MxM displays a warning: deleting the group also deletes all the usernames in the group from your 
buddy list.  If you do not have those users listed elsewhere on your buddy list, you lose them from the 
buddy list and may have to re-enter them.  If you still want to delete the group, click on Continue. 

To change a group na

Group Name

3. Click on Rename Group. 

To delete a group: 

 

Figure 26: Deleting a Buddy List Group 
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Chapter 5 Places 
The Places tab appears in your main window only if your system has an MxM Places license. 

Places are basically permanent, named chat sessions. They have the same menus and menu options as 
chat sessions.  See the "Chat" section in the "Main Window" chapter.   

Places are arranged in a hierarchy, visible in the list shown in the Places tab of the main window. 

 

Figure 27: Main Window, Places Tab 

The MxM administrator creates the hierarchy of places, customizing the labels and icons to reflect your 
environment.  The examples used in this document are labeled as buildings, floors and rooms. 

26 MxM User's Guide 
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w 
n in the "Main Window" 

chapter.   

To go to a place, select its name from the hierarchical list, then double-click on it or click on Go.  MxM 
displays the place window, provided you have the permissions necessary to enter that place.  This windo
has the same menus and menu options as a chat session.  See the "Chat" sectio

 

Figure 28: Place Window  

If the MxM administrator has turned on History, you can see and scroll through chat records in the main 
text pane, going back as many days as the administrator has set for History.  If History is off, you only see 
the records for the current session, starting from when the first person entered the place in the current 
session. 

To keep your own copy of the history, go to the File menu and select Save Chat History…  The place 
thing that has appeared in the main text pane) in a text file.  When you 

dialog box that prompts you for the name and location of the text file. 

ote:  Only the place owner can eject occupants.  You become place owner by having the place assigned 
you by the MxM administrator. 

To invite someone to a place, go to the Users menu and select Add User… The option opens a window 
displaying online users whose permissions give them access to the room.  Select a user and click OK. 

saves the current history (every
pick this option, it opens a 

To remove an occupant from a place, the place owner selects their name in the Who's Here display, 
then clicks the Eject button. 

N
to 
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ce, without entering it, hold your mouse pointer over the place's name 
nts, their usernames appear in a small display. If the list has been displ

long time, click the  button first, to get the most current information. 

To see who is in a pla on the list.  
If there are any occupa ayed for a 

Refresh

 

Figure 29: Occupancy Display  

Owning Places 
Places can have owners assigned by the MxM administrator.  The owner of a place has access to the place 

owners by and can eject other occupants from the place. The administrator controls access for non-
assigning privileges.   
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Chapter 6 Media 
To use MxM Audio, you need to have:  

 An MxM Audio license on the system. 

Audio enabled on your MxM client. (See the section " 

 Media Settings Tab," later in this chapter.) 

 A headset or speaker and microphone connected to your computer. 

You can then carry on a verbal conversation with anyone with whom you are sharing an MxM chat 
session.  Users with audio capability have this icon:  in front of their display names in the Who's Here 
display of chat sessions and places. 

<< If you have audio trouble, see the Troubleshooting appendix [TBS] >>  

 

Figure 30: Chat Window Showing Audio Features  

The chat window has the following audio features: 

Level meter — This bar graph shows how loudly you are speaking, as a percentage of maximum volume. 
You can turn off this display with the Media Settings tab; by default, it is on. 

Talk — Hold this button down to be heard when you speak.  Press Shift and click on Talk to lock it 
down; click again (without Shift) to unlock it. When the button is down, the  icon changes to  . 

Mute All / Unmute All — Click this button to turn off all audio from other users.  You can still be heard.  
The button toggles to Unmute All; click again to restore audio. 

Mute — Click this button to turn off audio from users you have selected from the Who's Here pane. 

Unmute — Click this button to restore audio from users you have selected from the Who's Here pane. 
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To select multiple users in the Who's Here pane, hold down Ctrl and click on your selections.  Hold 
down Shift for consecutive selection. 

<< translation buttons >> 
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Media Settings Tab 

 

Figure 31: Media Settings Tab 

The Media Settings tab appears in your Preferences window only if your system has an MxM Audio 
license. 

Under this tab, you can specify settings for audio chat: 

Enable Audio — Select to enable audio chat with other users.  The default is Enabled.  The setting takes 
effect the next time you log in to MxM. 

Use Local UDP Address — The default is unchecked.  Enter the IP address of your local computer if 
directed to by your MxM administrator. You will need to do this only if your local computer uses 
multiple network interfaces.  The setting takes effect the next time you log in to MxM.  

Local Port — Reset this if directed to by your MxM administrator.  The setting takes effect the next time 
you log in to MxM. 

Management Port — Reset this if directed to by your MxM administrator.  The setting takes effect the 
next time you log in to MxM. 

Silence Threshold — Enter the volume level at which audio stops transmitting.  The default value is 2.  
The more background noise you have, the higher you may want to set it. 

Shared View Port — Reset this if directed to by your MxM administrator.  The setting takes effect the 
next time you log in to MxM. 

Display Level Meter — Select to display a bar meter at the bottom of the chat session window, showing 
current volume level. 
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nable Auto Gain Control — Select to "flatten" volume, making loud sounds softer and soft sounds 
louder.  

 Control — Select to suppress echoes.  This is generally 

— Click to display help on the media settings. 

t audio chat session.  Many settings only take effect the next 
time you log in to MxM. 

Cancel — Click to close the Preferences window. 

 

E

Enable Acoustic Echo needed only if your 
system uses separate speakers and a microphone rather than a headset.  

Help 

Save — Click to save selections for the nex
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Chapter 7 Whiteboard 
The Whiteboard tool is a graphics tool that can be viewed and used by all users in a place or chat session.  

To open the whiteboard, go to the Tools menu of a place or chat session and select Whiteboard from the 

 

menu.  MxM displays a blank whiteboard. 

 

Figure 32: Whiteboard 

The whiteboard is visible to everyone in the chat session and usable by them. You can open and close the 
whiteboard without losing work as long as the chat session continues, or as long as the room remains 
occupied. 

To close the whiteboard, click on the  icon in the upper righthand corner, or use the lose option on 
the File menu. 

 C
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File Menu 

 

The File menu lets you save or import images. 

Clear Canvas — Select to remove all objects and any background.  

Save As... — Select to open the Save window and save the whiteboard image to a file.  Navigate to 
whe ick on Save.  re you want to save the file, enter a file name, and cl

 

Figure 33: Whiteboard Save Window 

Background > — Select to open the background menu:  

 

Figure 34: Background Menu 

34 MxM User's Guide 
 



Whiteboard  Chapter 7 

Background Image URL... — Select to open the Input window and choose a background image for 
the whiteboard.  Enter the URL for the image and click on OK.  The whiteboard displays the specified 
image in the background; you can then draw on it normally. Supported image types are .gif, .jpg, and 
.png. 

 

Figure 35: Whiteboard Background URL Input 

 Image Upload... — Select to open the Select window and choose a background image 
Select.  The whiteboard displays the 

specified image in the background; you can then draw on it normally. Supported image types are .gif, 
.jpg, and .png. 

Background
for the whiteboard.  Navigate to the image and click on 

 

Figure 36: Whiteboard Background Upload Window  

Clear Background Image — Select to remove any background image.  
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Canvas Size... — Select to open the Canvas Size window and choose a size for the canvas, the available 
drawing area, of the whiteboard.  Enter the width and height, in pixels, and click on OK.  The new canva
size takes effect immediately nd is visible to all whiteboard users in the session.  The white

s 
 a board deletes 

any objects not contained in the new dimensions of the canvas.  Scroll bars appear when the canvas is 
larger than the current whiteboard window. << Move to Canvas Menu, when it shows up. >> 

 

Figure 37: Whiteboard Canvas Size Window 

Edit Menu 

 

This menu lets you copy, cut, and paste whiteboard objects. 

Cut — Select o move all selected images to the paste area.  

aste area.  

images in the paste area to the whiteboard.  

Delete — Select to remove all selected images.  

 — Select to mark all images on the whiteboard as selected.  

Delet  — Select to remove all images from the whiteboard.  

 t

Copy — Select to copy all selected images to the p

Paste — Select to copy the 

Select All

e All

Format Menu 

 

This menu lets you specify general image properties. 

Align — description << not working yet >> 

Font — Click to open a font selection window.  << I suppose.  Not working yet. >> 
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F r 
the whiteboard.  The default value is nothing, no fill.  This menu option works the 

same as the fill color button 

ill Color — Click to open a color chooser window.  You can use this window to select the interior colo
for shapes drawn on 

 .  See the "Color Selections" section for more information.  

or chooser window.  You can use this window to select the color for 
straight lines, doodles, and the borders of shapes drawn on the whiteboard.  The default value is black.  
Thi

Line Color — Click to open a col

s menu option works the same as the line color button  .  See the "Color Selections" section for 
mor

Vie

e information.  

w Menu 

 

This menu lets you control the general appearance of the whiteboard. 

History — Check this box to display the History pane.  See the "History Pane" section for more 
information.  

World Map Backgrounds 1 and 2 — Check either of these boxes to select one of the supplied maps as 
background for the whiteboard.  You can then draw on them normally.  

Help Menu 

 

Whiteboard — Click for help on the whiteboard.  

Drawing Controls 

<< Re-capture when Save shows up.  >> 

Save — Click open the Save window and save the whiteboard image to a file.  Navigate to where you 
want to save the file, enter a file name and type, and click on Save.  << I suppose.  Not working yet. >> 

 Delete — Deletes the currently selected objects from the whiteboard. 

Text — Click here, then click and drag on the whiteboard to create a text area, where you can enter text 
by typing.  Click outside the text box to close the box, leaving the text in the picture.  

Font selection — Use this pulldown menu to select the font for use in the next text box.  

Text size — Use this pulldown menu to select the size of the text in the next text box. 

  Bold  — Click here to specify the text in the next text box will be bold.  Results are not visible until the 
text box closes. 
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tion sty

Rotate — << TBS >> 

Scale — << TBS >> 

 Italic — Click here to specify the text in the next text box will be Italic.  Results are not visible until 
the text box closes. 

Animations — Use this pulldown menu to select the anima le for the objects you draw next. The 
available animation options are:  

Fade — The object fades out over a few seconds, then return to normal.  

 Single-Select — Click here to select an object by clicking on it.  

 
co

Box-Select — Click here to select one or more objects by dragging the pointer to define a box 

Selected objects are marked by a red frame. 

ntaining them.  An object must be completely inside the box to be selected.  

 

Figure 38: Single-Select, Box-Select, and Selected Object 

 Line — Click and hold, then drag the mouse to draw a straight line.  Use the line color control , line 
width control , line style control , arrow style control , and opacity control to choose the style of 
the line.  

Rectangle — Click and hold, then drag the mouse to draw a rectangle. Use the line color control ,  
line width control  and line style control  to select the style of the rectangle's border.  Use the fill 
color control, , and the opacity control to choose the contents of the rectangle.  

Oval — Click and hold, then drag the mouse to draw an ellipse. Use the line color control,  , line 
width control , and line style control  to select the style of the ellipse's border.  Use the fill color 
control, , and the opacity control to choose the contents of the ellipse.  

Doodle — Click and hold, then drag the mouse to draw a free-form line.  Use the line color control ,  
line width control , line style control , and opacity control to select the style of the line.  

 Line color — Click to open a color chooser window.  You can use this window to select the color for 
straight lines, doodles, and the borders of shapes drawn on the whiteboard.  The default color is black.  

: The color of the line at the bottom of the icon shows the current selection    See the "Color 
Selections" section for more information.  
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 Fill color — Clic
color for shapes drawn on the whiteboard.  The defaul

k to open a color chooser window.  You can use this window to select the interior 
t value is nothing, no fill.  The color of the line at 

   See the "Color Selectiothe bottom of the icon shows the current selection: ns" section for 
more information.  

 Line width — Click to open a menu of line widths, then click on the line width you want.  This width 
applies to doodles and figure borders as well as to straight lines.  

 

Figure 39: Line Width Menu 

 Line style — Click to open a menu of line styles, then click on the style you want.  This style applies 
to doodles and figure borders as well as to straight lines.  

 

Figure 40: Line Style Menu 

 Arrow style — Click to open a menu of arrow styles, then click on the style you want.  This style 
applies only to straight lines.  

 

Figure 41: Arrow Style Menu 

 to display the opacity slider.  Click and hold on the slider button, then move it Opacity — Click here
back and forth to control the opacity of selected objects and objects drawn later.  Move it all the way to 
the right for completely opaque, or all the way to the left for completely transparent.  

 

Figure 42: Opacity Control 

Mouse Controls 

<< There will be a button to click, to enable the following mouse functions. >> 

<< There will be an enable of some sort button to replace Ctrl/T. >> 
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Move Objects 

To move an object, select it with Single-Select or Box-Select, then click and drag it.  

age with 

Identify Object Makers 

To see who drew a particular object, hold the pointer over the object.  After a few seconds, the 
whiteboard displays the drawer's name.  

Move Canvas 

To move all objects on the screen, hold down the Shift key and the left mouse button, then drag the 
pointer.  All objects on the screen move, including background images.  Return to the original im
Ctrl + T.  

 

Enlarge Selection 

To enlarge a selected area of the whiteboard, hold down the Ctrl key and the left mouse button, then 
drag the pointer over the area to be enlarged.  When you release, the selected area fills the screen.  Return 
to the original image with Ctrl + T.  

Zoom In and Out 

To zoom in or out, hold down the Shift key and the right mouse button, then move the point up (to zoom 
out) or down (to zoom in).  The image zooms in or out around the point where you started dragging.  
Return to the original image with Ctrl + T.  

Rotate Canvas 

down the Ctrl key and right mouse button, then move the pointer.  The 
canvas rotates around the center point.  Return to the original image with Ctrl + T.  
To rotate the entire canvas, hold 
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History Pane 

By default, the whiteboard displays the History pane, on the right side.  

To turn the history pane off or on, use the History checkbox on the View menu. 

H  the 

thumbnail shows the object as the action left it and user's display name.  (Object deletions are shown as 
crossed-out thumbnails.) 

Every time a user adds, deletes, or modifies an object, the istory pane displays a thumbnail image of
whiteboard canvas, up to the last five actions.  The most recent action is shown at the top.  Each 

 

Figure 43: Whiteboard History 

n the whiteboard together, on the Whiteboard tab, or the history 
Object

To track the history of an individual object: 

1. Select the object and right-click it.  The whiteboard displays a View Object History box. 

2. Click on the View Object History box.  The History pane switches to the Object tab 

To return to the whiteboard history, click on the Whiteboard tab in the History pane. 

You can track the history of all objects o
of an individual object, on the  tab. 
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Color Selections 

You can pick 

1. Click the line color butt

the colors for lines or fill through a color chooser window.  

To open a color chooser window: 

on  or the fill color button  .  The whiteboard opens a color menu:  

 

Figure 44: Color Menu 

2. Click More Colors…  

Or se

There are six styles of color chooser.  To select a style of color chooser, click on the style's icon at the 
top of the window.   

lect the Line Color or Fill Color options on the Format menu.   

 

Figure 45: Color Chooser Style Icons 
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The styles are: 

  Color wheel — This is the default style of color chooser.  Select hue and saturation from the color 
wheel and use the slider to control brightness. 

  
the pulld

Color sliders — Select color attributes using the sliders.  There are five sets of sliders; select from 
own menu.  RGB Sliders is the default. 

 

  
pulldown

Color palettes — Select a color from one of the palettes.  There are three palettes; select from the 
 menu.  Apple is the default. 

 

  Color swatches — Select a color from the array of color swatches.  If you hold your mouse 
pointer over a swatch, MxM displays the RGB values for that swatch. 

  Crayons — Select a color from the crayons pictured in the box.  This color chooser has the same 
colors as the Crayons palette. 

  Xoetrope color wheel — Select a color from the color wheel, then adjust saturation and brightness 
with the sliders on the side.  Click on the boxes at the bottom to limit selections to web-safe colors, or to 
display RGB values in decimal rather than hexadecimal notation. 

In all styles, the color chooser shows the current selection in a bar at the top of the window.  If you hold 
your mouse pointer over the bar, MxM displays the RGB values for the selected color. 

In all styles, you can use the magnifying glass  to select a color from anywhere on the screen.  To 
select color by magnifying glass:  

mouse pointer becomes a magnifying glass 1.  Click on its button. Your  , showing an enlarged 
view of the screen beneath it.   

2. Select a pixel anywhere on the screen and click.  The whiteboard selects the pixel's color and the 
mouse pointer returns to its usual state. 
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Chapter 8 Shared View
The Shared View tool lets all the users in a chat session view a section of one user's screen while th
have their discussion.   

 
ey 

To join a Shared View session, select Shared View from the Tools menu in a place or chat session.  
MxM displays the Shared View window, initially blank.  

 

Figure 47: Shared View Window on Opening 

he 

To control a Shared View session:  

1. Click on Drive at the top of the Shared View window. You are now the driver.  On your display, t
Shared View window is replaced by the driving window, framing part of your screen.  

 

Figure 48: Shared View Driving Window  
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2. Click on Sharing, at the top of the driving window.  For chat members with Shared View on, the 
Shared View window shows the contents of your driving window and your username appears in the 

n move and re-size the frame as you would any other 
window. 

Driver field.  As driver, you can control what the others see in the driving window by moving and re-
sizing the frame on your screen.  You ca

 

Figure 49: Shared View Window, Watching 

As the driver, you can work in the Shared View frame normally.  Thus, other users can watch while you 
use an application, edit a document, and so forth.  They can see what you are doing, and, through the 
continuing chat session, comment or ask questions. 

Any user can become driver by clicking on their Drive button.  The driver is whoever clicked last.  The 
current driver's username appears in the Driver field at the top of the Shared View window. 

Note: You cannot drive the display on another user's computer.  When you are driver, you can show 
part of your display to the other people in the Shared View session. 

To leave a Shared View session, click on the  
w

button on the Shared View window.  You can re-enter 
the Shared View session by selected Shared Vie  from the Tools menu again.  

Leaving the chat session automatically means leaving the Shared View session, but you can resume the 
Shared View session if you re-join the chat and select Shared View again. 

If the driver leaves the Shared View session while driving, the Shared View window goes blank for all the 
remaining users, but another user can begin driving, showing sections of their screen to the others. 

To take a snapshot in Shared View, click on Copy at the top of the Shared View window.  The image in 
the Shared View window is copied to your clipboard.  
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specific window exactly, when driving: 

1. Click on  at the top of the driving window.  Shared View opens a pulldown menu, listing all 
 on the display.   

me of the window you want to display oves the driving window to fit 
cted window, so that all of it i .   

dow being tracked, the  re-sizes with it. 

ething over the tracked window, it a s. 

Th  button at the top of the Shared View wind

To display a 

 Tracking
the windows currently

2. Click on the na .  Shared View m
exactly around the sele s displayed to the other users

If you move or re-size the win  driving window moves and

If you move som ppears to the other user

Telepointer Tool 

e crosshairs ow,  , is the telepointer tool.   

inter, click on the telepointer button an tion in the Shared 
ays as crosshairs when it is in the w window and is 

ter, click on the hand icon, 

To use the telepo d point to your selected loca
Shared VieView window.  Your mouse pointer displ

visible to all users in the Shared View. 

 To turn off the telepoin . 
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